MICROSOFT® OFFICE

Word 2007

Word Tutorial 1

Creating a Document

NEW PERSPECTIVES
COMPREHENSIVE



Objectives

* Plan a document
* |dentify the components of the Word window
* Set up the Word window

* Create a new document
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Objectives

e Scroll a document and move the insertion point
* Correct errors and undo and redo changes

* Enter the date with AutoComplete

* Change a document’s line and paragraph spacing

e Save, preview, and print a document

* Create an envelope
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Four Steps to a Professional Document

* Microsoft Office Word 2007 (or simply Word) is
a popular word-processing program

* The most efficient way to produce a document is
to follow these four steps:
— Planning
— Creating and editing
— Formatting

— Printing or distributing online.
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Four Steps to a Professional Document

Completed block style letter

cU

Carlyle University Press
1422 lvy Tree Lane
Albarty, New York 12205
press@carlyle.university.edu

February 8, 2010 =& date

Clara Meyer l PR
inside
2257 Chamberlain Drive J -

address

North Liberty, IA 52317

Dear Clara: - salutation

Enclosed you will find the Author’s Guide we discussed at our meeting. | think it will answer all your A

entire letter questions.

aligned
along left
margin

Y

See Chapter 1 for a complete explanation of the publishing process, including the copy editing phase.
Chapter 2 discusses the process of creating a text manuscript in Microsoft Word. Chapter 3 explains how I bOdY |
to compile an electronic art manuscript to accompany your text.

A

| will call in a few days to discuss the schedule. Feel free to call me before then if you prefer. | will be
traveling next week, but you can always reach me on my cell phone. | also plan to check my e-mail while
| am on the road. 4

complimentary
Sincerely yours, closing

_—
-

Andrew T. Suri

signature
L line
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Exploring the Word Window

Figure 1-2 Maximized Word window
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Exploring the Word Window

Window Element  Description

Office Button Provides access to the Word Options dialog box and to commands that control
what you can do with a document that you have created, such as saving, print-
ing, and so on

Ribbon Provides access to commands that are grouped according to the tasks you per-
form in Word
Tabs Provide one-click access to the groups of commands on the Ribbon; the tabs you

see change depending on the task you are currently performing

Quick Access Toolbar  Provides access to common commands you use frequently, such as Save

Rulers Show page margins, tab stops, row heights, and column widths
Insertion point Shows where characters will appear when you start typing
Paragraph mark Marks the end of a paragraph

View buttons Allow you to change the way the document is displayed
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Opening a New Document

* Click the Office Button in the upper-left corner
of the Word window and view the menu of
commands that opens

 Click New

e Verify that the Blank document option is \
selected (that is, highlighted in orange), and then 3
click the Create button at the bottom of the

dialog box
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Opening a New Document

Figure 1.5 New Document dialog box
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Selecting Print Layout View

* You can use the View buttons in the lower-right
corner of the Word window to change the way
your document is displayed

: Print Layout other view

button is buttons

orange to

show it is

selected L ] °
- L—dh— S
Page:lofl E

\
Wores®:{/ 5 EEEan o0
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Displaying the Rulers

* Click the View tab

* |In the Show/Hide group, click the Ruler check
box to display a checkmark

Dispayin th rlers
L/l:'.'!;;\ Document2 - Microsoft Word —igmg - b
) [Fome tab]

Home Insert Fage Layout References  Mailin 95 Review View

_” -.l:u g [ V| Ruler Document t Map q 1_ donerage | CE New Window | 1) View Side by Side

I Gridlines Thumbnails =28 Q'rwn Pages a Arrange All 1} Symchronous Scrolling

| Print {Full Screen Web  Outline Draft . : Zool . L .

layout | Reading Layout Message Bar 22 Page Width | = Split 44 Reset Window Position
nnnnnnnnnnnnnnnnnn /Hide Z Window

[ —————————— : —

Ruler
check box

horizontal ruler

vertical ruler
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Displaying Nonprinting Characters

* Nonprinting characters are symbols that appear
on the screen but are not visible on the printed
page
In the Paragraph group on the Home tab, click

the Show/Hide 4] button
Nonprinting characters displayed

= [ TR T
&) +—| Show/Hide § button |
— Home Insert Page Layout Reference @
= A . i | (8 ] P 3 Find -
B S Calibri (Body) 11 A x| == e T | AaBbCcDc | AaBbccDc AaBbCi AaBbCe % P
Paste 4 [B T U - e x x' Aar|[¥- A-|EFE R B = - H- T Mo Spaci.. Headingl  Heading2 - Change
Clipboard = Font M Parggraph [} Styles = Editing
EI"S — | B e — 5
-

g Paragraph groupi ‘
. f~«——— paragraph symbol | k ‘
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Checking the Font and Font Size

 The term font refers to the shape of the
characters in a document

 Font size refers to the size of the characters

Font settings Figure 1-9
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Checking the Zoom Setting

e Zoom level controls the document’s on-screen
magnification

e Setting the Zoom level to Page Width shows the
entire width of the document on your screen

m Options for changing the Zoom setting

[ Zoom Out button |—

[ Zoom level; yours might differ |——

Zoom In button
A

/
3 2 E gl

Y
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Saving a Document for the First Time

* Click the Save button on the Quick Access
Toolbar

* Type a name in the File name text box

e Click the Save in list arrow, and then select the
location where you want to save the file

 Click the Save button at the bottom of the Save
As Dialog box
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Saving a Document for the First Time

4] Save As

®v| v Tutorial0l » Tuterial - |¢1~ | |Search e |

‘ Organize =

Favorite Links Date modif.. Type Size
| Templates This folder is empty.
E| Documents

Bl Desktop

v
1= Recent Places

1M Computer

E Pictures
More »
Folders -~
File name:  Meyer Letter] -
Save as type: ’Wurd Document -
Authors: User Mame Tags: Add atag
[] Save Thumbnail
# Hide Folders Tools - Save I [ Cancsl
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crolling a Document

Scrolling the document window

r’@ FEE A Meyer Letter - Microsoft Word -8 X
- Home | Insert Page Layout References Mailings Review View @
_j _’: cciL et -[u - faaE) | T4 | asevcenc | asebcenc AaBbCi AaBbCe % i:::_;t '
Paste 5 (B Z U -abe x, X Aac |- 4 -1 W WS- S B- ||| thomal | TNoSpaci.. Headingl Heading2 = g::ff I select -
Clipboard Font i Paragraph i Styles - Editing c’iCk to
=1 . DI T o n T = |scroll up
questions.q one line
or click
SeeChapter-1fora-complete-explanation-ofthepublishing-process,includingthe-copy-editingphase.- and hold
Chapter-2discussestheprocess-ofcreating-atext-manuscriptin-Microsoft- Word.Chapter-3-explains-how-
to-compile-an-electronicart-manuscript-to-accompany-your-text.q
lwillcall-ina-few-daystodiscusstheschedule. Feelfreeto-callmebefore-thenif-you-prefer.--will be-
traveling nextweek, butyou-can-alwaysreachme-on-my<ell phone.l-also-plantocheck-my-e-mailwhile-
I+ ntheroad.
am-onthe-road.q drag the
Sincerelyyours, 9 scroll box
T up or down
Andrew-Suri
k
click to
scroll
down one
screen or
click and
hold

4
Pagelotl  Words1l9 S [EEEEET™ o]
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Moving the Insertion Point

Around a Document

* To change the location in the document when
you type, you need to move the insertion point

Keystrokes for moving the insertion point Figure 1-19

To move the insertion point Press

Left or right one character at a time €~ or—>

Up or down one line at a time T or ,l,

Left or right one word at a time Ctrl+ €= or Ctrl+ =

Up or down one paragraph at a time Ctrl+ T or Ctrl+ ,L

To the beginning or to the end of the current line Home or End

To the beginning or to the end of the document Ctrl+Home or Ctrl+End

To the previous screen or to the next screen Page Up or Page Down

To the top or to the bottom of the document window Alt+Ctrl+Page Up or Alt+Ctrl+Page Down
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Using the Undo and Redo Commands

* To undo (or reverse) the last thing you did in a

document, you can click the Undo button on the
Quick Access Toolbar

* |f you want to restore your original change, the
Redo button reverses the action of the Undo
button (or redoes the undo)

Using the Undo button

+—| Undo button | [ Redo button |

Shyles
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Correcting Errors

* |f you notice a typing error as soon as you make
it, you can press the Backspace key

* AutoCorrect automatically corrects common
typing errors, such as typing “adn” for “and”

 Word’s spelling checker continually checks your
document against Word’s built-in dictionary

e Before you can practice using AutoCorrect and
the spelling checker, you need to verify that you
have the correct settings in the Word Options
dialog box
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orrecting Errors

Figure 1-21 Selecting AutoCorrect options
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Correcting Spelling Errors

Figure 1-23 Shortcut menu with suggested spellings
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Inserting a Date with AutoComplete

 Word’s AutoComplete feature automatically
inserts dates and other regularly used items for
you

63 Hd9-0 )+ Meyer Letter - Microsoft Word
~ Home | [Insert Pagelayout  References Mailings  Review Vi w
B " Calibri (Bady) “ju AR || =t e QT s oonceoc| assbecoc AaBBCi AaBbCe
| Paste ; (B - o " A% - A (EE W WE|E | 5E TNomal {1 No Spaci..| Heading | Heading 2 = & I:‘se
| ¥ ¥
I Clipboard fs Font fe Paragraph M Styles
E'} s
“| the complete name
of the month
1
1
11 ) . .
i’FeD:an (Press ENTER 10 105 e dlrealons te" you how to
ebrfn enter the rest of the word
1
Dear{lara:q
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Understanding Line

and Paragraph Spacing

* Line spacing determines the amount of space
between lines of text within a paragraph

* Paragraph spacing determines the amount of
space before and after a paragraph

e Paragraph spacing is measured in points

— A point is approximately 1/72 of an inch
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Understanding Line
and Paragraph Spacing

Line and paragraph spacing in the letter to Clara Meyer

1
1

= = DearClara:f
Enclosed, youwill-find the -Author's Guide we discussedat-our meeting.- I think-it-will- answer all your.
questions. 9
SeeChapterdfor-acomplete ionof the publishing-process, ding-the copy-editing-phase.-

of Chapter 2 discussesthe processof creating a text-manuscriptin-Micrpsoft Word Chapter-3-explains how 3 I
tocompile an-electronic artmanuscriptto-accompany yourtext®

these are both will-callina few-days to-discuss the schedule Feelfree to-call me-before then if.you prefer iwill-be
ra |"|5 L4 travel ngnextweek, but-you-can-always-reach-me-on-my-cell phone -|-also-planto-checkmy-e-mail-while:
para'g p am-on-the-road 91

~«— default paragraph spacing
SR looks like double spacing

1

AndrewT. Surig zoom set to 90%
. for this figure only

Page i ott | Worssi22 | S [EEnng - e ———0
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Selecting Parts of a Document

* With the mouse you can quickly select a line or
paragraph by clicking the selection bar

Figure 1-28 Methods for selecting text

To Select
A word

Mouse
Double-click the word

Keyboard

Move the insertion peint to
the beginning of the word,
hold down Ctrl+Shift, and
then press =»

Mouse and Keyboard

Aline

Click in the selection
bar next to the line

Move the insertion point to
the beginning of the line,
hold down Shift, and then
press

A sentence

Click at the beginning
of the sentence, then
drag the pointer until
the sentence is
selected

Press and hold down Ctrl,
and then click within the
sentence

Multiple lines

Click and drag in the
selection bar next to
the lines

Move the insertion point to
the beginning of the first
line, hold down Shift, and
then press .[, until all the
lines are selected

A paragraph

Double-click in the
selection bar next to
the paragraph, or
triple-click within the
paragraph

Move the insertion point to
the beginning of the
paragraph, hold down
Ctrl+Shift, and then

press

Multiple paragraphs

Click in the selection
bar next to the first
paragraph in the
group, and then drag
in the selection bar to
select the paragraphs

Move the insertion point to
the beginning of the first
paragraph, hold down
Ctrl+Shift, and then

press i until all the para-
graphs are selected

An entire document

Triple-click in the
selection bar

Press Ctrl+A

Press and hold down
Ctrl, and then click in the
selection bar

A block of text

Click at the beginning
of the block, and then
drag the pointer until
the entire block is
selected

Click at the beginning of the
block, press and hold down
Shift, and then click at the
end of the block

Nonadjacent blocks
of text

Press and hold down
Ctrl, and then drag
the mouse pointer to
select multiple blocks
of nonadj text
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Adjusting Paragraph and Line Spacing

* The quickest method to adjust paragraph and
line spacing is to click the Line spacing button in

the Paragraph group on the Home tab
Line and paragraph spacing options

r’[‘:‘!—_- o9 - s Meyer Letter - Microsoft Word - n x
) Line spacing button |
Home Insert Page Lavout References Mailings Rewvis i &
=Lk z - el s | 4 Fing ~
L cvor o i SN o] SR SR | AsBbCcDc| AsBbcoe AaBbCi AaBbGc — M Pk
| changs | s

B
P 7 (B I U A =2- A-|| e = W[z S -] | rrome [1Nospac.. Heading 1 Heading2 | Soeat || Iy seteee
| clipboara & Font [r] Parag| 10 | Styles | Editin

I e —— " F ey &
5 Bt line spacing
= . options
ing O
g Add Space Before Paragraph L] paragraph .
5 Remove Space After Paragraph spacing options
1
1
" s =
this option removes
1 extra space between
S the selected paragraphs
"
ClaraMeyery
2257 ChamberlainDrivey
Northiiberty,1A523179
1
Dear{larazy
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Previewing and Printing a Document

* To avoid wasting paper and time, you should first
display your document in the Print Preview
window

* Click the Office Button, point to Print, and then
click Print Preview

* To print your document, click the Office Button,
and then click Print

— Verify settings in the Print dialog box, and then click
the OK button
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Previewing and Printing a Document

Figure 1-32 Full page displayed in the Print Preview window
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Creating an Envelope

* Creating an envelope is a simple process because Word
automatically uses the inside address from the letter as
the address on the envelope

* Click the Mailings tab on the Ribbon

* In the Create group, click the Envelopes button to open
the Envelopes and Labels dialog box

* Verify that the Delivery address box contains the correct
address. If necessary, type a new address or edit the
existing one

* If necessary, type a return address. If you are using
preprinted stationery that already includes a return
address, click the Omit check box to insert a check mark
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Creating an Envelope

* To print the envelope immediately, insert an
envelope in your printer, and then click the Print
button

* To store the envelope along with the rest of the
document, click the Add to Document button

* To print the envelope after you have added it to
the document, insert an envelope in your
printer, open the Print dialog box, and print the
page containing the envelope
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Creating an Envelope

Figure 1-33 Envelopes and Labels dialog box
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